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Getting Started with AquaLogic Commerce 
Services  
This guide is designed to give you a starting point for getting running with AquaLogic Commerce 
Services. It includes the following 

• Installing AquaLogic Commerce Services 

• Running AquaLogic Services with other WebLogic Server and WebLogic Portal applications 

• Adding AquaLogic Commerce Services to a domain 

• Using Workshop for WebLogic with AquaLogic Commerce Services 

• Making modifications 

• Implementing Unified User Profile with WebLogic Portal 

• Integrating with back-end systems 

• Integrating BPM functionality 

• Hooking into your e-mail server 

Installing AquaLogic Commerce Services 

BEA AquaLogic Commerce Services is very easy to install as it provides an automated installer 
which places the application in your existing BEA WebLogic Server installation. 

NOTE: IF YOU ALREADY HAVE AN EARLIER VERSION OF AQUALOGIC COMMERCE 
SERVICES INSTALLED, PLEASE READ THE SECTION TITLED “UPGRADING AQUALOGIC 
COMMERCE SERVICES” IN THIS DOCUMENT FOR DETAILS ON HOW TO UPGRADE. IF YOU 
PERFORM AN INSTALLATION WITHOUT FOLLOWING THE UPGRADE STEPS YOU WILL LOSE 
ANY DATA AND CUSTOMIZATIONS YOU HAVE MADE! 

What AquaLogic Commerce Services installs 

The AquaLogic Commerce Services installation includes the following 

Module Description 

AquaLogic Commerce Services 
Template 

A template for easily creating new AquaLogic Commerce 
Services deployments 

AquaLogic Commerce Services 
Sample 

A sample deployment of AquaLogic Commerce Services with a 
preconfigured demo store 

AquaLogic Commerce Services 
WLP Plugins 

Plug-in modules for integrating AquaLogic Commerce Services 
with WebLogic Portal 
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Options during installation 

The installation tries to find the root folder of your BEA installation to use to install AquaLogic 
Commerce Services, but it also provides an option to choose the installation folder should you 
have an unusual configuration. 

The installer also allows you to customize which of the modules gets included in the installation. 

Where to find everything 

The installer will place AquaLogic Commerce Services in the following locations beneath 
<BEA_HOME>/weblogic92 

• commerce/database-scripts - scripts for setting up the AquaLogic Commerce Services 
schema in the supported databases. 

• commerce/portal-plugins - plug-ins for integration with WebLogic Portal. 

• commerce/uninstall - allows you to uninstall AquaLogic Commerce Services. 

• samples/commerce/commerceApp - the sample application including Commerce Storefront, 
Commerce Manager and Commerce Integration. 

• samples/domains/commerce - the domain for the sample application. 

• common/templates/applications/commerce-services.jar - the template to use for your own 
deployment. 

Windows menus 

The Windows installer adds a Commerce Services menu to the BEA Products > Examples menu 
of the Start > Programs menu, containing the following links 

• Start Commerce Services Example Server 

• Stop Commerce Services Example Server 

• Visit Commerce Manager Example 

• Visit Storefront Example 

Linux symbolic links 

The Linux installer adds the following symbolic links to your home directory to make it easy to 
start the examples: 

• startCommerceServicesExampleServer 

• stopCommerceServicesExampleServer 

• Commerce Services Manager 

• Commerce Services Sample 
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Upgrading AquaLogic Commerce Services 
Upgrading to a newer version of AquaLogic Commerce Services can be done with 
minimal impact by performing the following steps to ensure your customizations and data 
are preserved. 

Shut down AquaLogic Commerce Services domains 

Firstly, ensure your current AquaLogic Commerce Services domain is shutdown. You can 
shutdown the sample domain as follows: 

• In a Windows environment, select the “Stop Commerce Services Example Server” menu 
option from the BEA Products > Examples menu 

• In a Linux environment, use the stopCommerceServicesExampleServer symbolic link 
from your home directory. 

Any additional domains you have created that include AquaLogic Commerce Services can be 
shutdown by using the stopWebLogic command in the domain’s bin folder. 

Backing up important files 

To preserve any data you have changed or entered in AquaLogic Commerce Services you should 
backup your database. 

• If you are still using the database that was installed with AquaLogic Commerce Services, 
you should make a backup copy of this by copying the commerce_sample folder from 
your domain folder to a safe location. The default installation of AquaLogic  Commerce 
Services uses <BEA_HOME>/weblogic92/samples/domains/commerce. 

• If you are using a different database to the one installed with AquaLogic Commerce 
Services, you are not required to make a backup but it is good practice to do so anyway 
(using the standard backup strategy for your chosen RDBMS). 

If you have made some customizations to the code in the Storefront demo store application, you 
should backup those changes before performing the upgrade. 

• Copy the commerceServices folder from the sample application folder to a safe location. 
The default installation of AquaLogic Commerce Services uses 
<BEA_HOME>/weblogic92/samples/commerce/commerceApp. 

Uninstalling existing AquaLogic Commerce Services 
Deployment 

Once you have backed up any essential data and/or customizations, you should uninstall the 
existing installation of AquaLogic Commerce Services as follows: 

1. Go to the <BEA_HOME>/weblogic92/commerce/uninstall folder 
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2. Run the uninstall executable 

3. Follow the prompts in the uninstaller program. It will take a few minutes to remove 
all the AquaLogic Commerce Services files from your system. 

AquaLogic Commerce Services will now be uninstalled from your system. Note, if you have 
created any new domains using the AquaLogic Commerce Services template these will not be 
affected (and will still be using the old version). 

Installing the new version of AquaLogic Commerce Services 

Now you backup up your essential data/customizations and removed the old version of 
AquaLogic Commerce Services, you are ready to install the new and improved version. 

This is done exactly as before – see the “Installing AquaLogic Commerce Services” section 
earlier in this document. 

Restoring your backups 

Database restoration: 

• If you were using the database that was installed with AquaLogic Commerce Services, 
you should now restore the backup copy you made of this earlier by copying the 
commerce_sample folder from your backup location to your domain folder. The default 
installation of AquaLogic  Commerce Services uses 
<BEA_HOME>/weblogic92/samples/domains/commerce. 

• If you are using a different database you do not need to restore anything, but please refer 
to the section below “Upgrading your database schema”. 

Restoring your customizations: 

• For any customizations you made to the previous version of AquaLogic Commerce 
Services, you may want to compare the files you customized to the new release versions 
rather than simply copying your customizations back over. This will allow you to merge 
your changes with any changes made as part of this release. 

• See the release notes for the new version to get a better idea of what may have changed. 

Upgrading your database schema 

If you are using a database other than the one which was installed with AquaLogic Commerce 
Services then you should run the database upgrade script for your database. The SQL scripts can 
be found in the folder: 

 <BEA_HOME>/weblogic92/commerce/database-scripts/upgrade. 

If you are using the default database you do not need to do anything further, as the database 
upgrade script consists only of some production database performance improvements. 
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Running AquaLogic Commerce Services with 
Other WebLogic Server and WebLogic Portal 
Applications 

AquaLogic Commerce Services is designed to run in harmony with other WebLogic Server and 
WebLogic Portal applications. 

Single Sign-On 

AquaLogic Commerce Services provides Single Sign-On (SSO) integration with other WebLogic 
Server and WebLogic Portal applications that are running in the same server instance. 

You may need to add the following section to your web application's weblogic.xml to ensure 
your application uses the same cookie as AquaLogic Commerce Services 

<session-descriptor> 

  <cookie-name>JSESSIONID</cookie-name> 

  <cookie-path>/</cookie-path> 

</session-descriptor> 

WebLogic Portal integration 

AquaLogic Commerce Services runs stand-alone on WebLogic Server, with no dependence on 
WebLogic Portal. However, if you do run WebLogic Portal, AquaLogic Commerce Services 
provides some integration that you may wish to use. 

It is important for this integration that AquaLogic Commerce Services and WebLogic Portal run 
on the same server instance (domain). This allows seamless Single Sign-on between AquaLogic 
Commerce Services and WebLogic Portal applications as well as providing WebLogic Portal 
with access to the AquaLogic Commerce Services Customer profile data through the Unified 
User Profile (UUP). 

Adding AquaLogic Commerce Services to a 
Domain 

It is quite easy to add the AquaLogic Commerce Services applications to a new or existing 
WebLogic Server domain. You may prefer to do this rather than make changes to the sample 
domain created by the installer. 

Creating a new domain using the AqualLogic Commerce 
Services template 

You can use the WebLogic Configuration to create a new domain based on the AquaLogic 
Commerce Services domain template included in the installation. Run the Configuration Wizard 
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and select the Create a new WebLogic Domain option. On the Select Domain Source page, 
select the Base this domain on an existing template and then Browse for the template which you 
can find at 
<BEA_HOME>/weblogic92/common/templates/applications/commerce_services.j
ar. You can then follow the rest of the configuration wizard as usual.  

Once you have created your new domain based on this template you can run the configuration 
wizard again to extend that domain to include other BEA products if you have them (e.g. 
WebLogic Portal, Workshop for WebLogic, etc). 

Deploying to an existing domain using WLST 

If you chose to install the AquaLogic Commerce Services sample application then you can easily 
deploy the sample app into your domain using the following wlst command. You may need to 
change some values to match your server configuration.  

commerceAppDir='<WL_HOME>/sample/commerce/commerceApp' 

 

connect('weblogic','weblogic','localhost:7011') 

deploy(appName='commerceServicesApp',path=commerceAppDir,stageMode='n
ostage') 

You will need to add a data source entry to your domain. This can be done through the WebLogic 
console or using wlst. An example script is shown below containing the settings for connecting to 
the sample derby database bundled with AquaLogic Commerce Services. 

createJNDI.py 

dsName="commercejndi" 

jndiName="jdbc/epjndi" 

 

connect('weblogic','weblogic','localhost:7011') 

 

 

edit() 

startEdit() 

 

jdbcSR = create(dsName,"JDBCSystemResource") 

theJDBCResource = jdbcSR.getJDBCResource() 

theJDBCResource.setName(dsName) 

 

connectionPoolParams = theJDBCResource.getJDBCConnectionPoolParams() 

connectionPoolParams.setConnectionReserveTimeoutSeconds(25) 

connectionPoolParams.setMaxCapacity(100) 

connectionPoolParams.setTestTableName("TCMUSER") 
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dsParams = theJDBCResource.getJDBCDataSourceParams() 

dsParams.addJNDIName(jndiName) 

 

driverParams = theJDBCResource.getJDBCDriverParams() 

driverParams.setUrl("jdbc:derby:commerce_sample") 

driverParams.setDriverName("org.apache.derby.jdbc.EmbeddedDriver") 

 

driverParams.setPassword("") 

driverProperties = driverParams.getProperties() 

 

proper = driverProperties.createProperty("user") 

proper.setValue("") 

 

save() 

activate() 

If you used the above script to create your data source then you will need to edit its configuration 
in your WebLogic console in order to target it to the desired server (ex. AdminServer). 

Using Workshop for WebLogic Platform with 
AquaLogic Commerce Services 

This section explains how to configure Workshop for WebLogic to prepare for developing 
customizations to the Commerce Services application. 

Creating the Project 
Take the following steps to create your project in Workshop for WebLogic 

1. Select File > New > Project. 

2. Select Java Project and click Next. 

3. Enter a name for the project, e.g. CommerceServices. 

4. Select “Create project from existing source.” 

5. Click Browse and navigate to this location: 
<BEA_HOME>\weblogic92\samples\commerce\commerceApp\commerceServices 

6. Click Next. 

7. In the Source tab, right-click WEB-INF/src/test/java under the project you created 
and select “Remove from build path.” 

8. Check “Allow output folders for source folders.” 

9. Click Finish. 
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Developing with Workshop for WebLogic 
• Read the BEA Workshop for WebLogic Platform documentation for more information on 

developing applications usig Workshop for WebLogic. 

• Read the AquaLogic Commerce Services Developer Guide for additional information on 
enhancing your development environment with plug-ins to assist with making enhancements 
to the AquaLogic Commerce Services applications. 

Making Modifications 

Once you've become familiar with the workings of the AquaLogic Commerce Services Storefront 
sample, you are going to want to make your own modifications. AquaLogic Commerce Services 
is designed with flexibility in mind so you can make changes relatively easily. 

Storefront folders 

The Storefront demo store application is in the commerceServices folder, which the installer 
puts in <BEA_HOME>/weblogic92/samples/commerce/commerceApp. You may wish to 
make a copy of this into your development folders. 

Most of the files you will want to modify will be in the following folders 

• template-resources - contains resources needed for the UI as follows  

o images - all the UI images used in the Storefront 

o js - JavaScript files used by the Storefront 

o stylesheet - CSS files used for the Storefront layout 

• WEB-INF/conf - configuration files as follows  

o misc - Miscellaneous configuration (validator and velocity toolbox) 

o resources - Properties files for Lucene, payment processors, country 
configuration 

o spring - Spring configuration files 

• WEB-INF/templates - Velocity templates for the Storefront pages 

• WEB-INF/src - Java source code 

Further reading 

The AquaLogic Commerce Services Developer Guide is rich with information on making 
changes to the Storefront application, including tutorials. Give it a read and you will be making 
advanced modifications in no time! 
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Implementing Unified User Profile (UUP) with 
WebLogic Portal 
AquaLogic Commerce Services includes a plug-in for WebLogic Portal that allows you to access 
AquaLogic Commerce Services Customer profile attributes using WebLogic Portal's Unified 
User Profile (UUP) functionality. 

The AquaLogic Commerce Services user profile property set 

The AquaLogic Commerce Services installation includes a property set file, 
<BEA_HOME>/weblogic92/commerce/portal-plugins/uup/CommerceServices.usr.  

Assuming you have already set up a WebLogic Portal EAR Project and Datasync Project in 
Workshop for WebLogic, copy the CommerceServices.usr file to your Datasync project's 
userprofile folder.  

 New to WebLogic Portal? 

If you aren't yet an expert on setting up Portal EAR and Datasync projects, 
follow the steps in the Getting Started with WebLogic Portal tutorial at 
http://edocs.bea.com/wlp/docs92/tutorials. 

The AquaLogic Commerce Services UUP shared library 

To use UUP in your portal project, the UUP shared library needs to be included. This can be done 
as follows 

1. Enter Workshop's Project Explorer view (Window > Show View > Project Explorer) 
and expand Enterprise Applications. 

2. Expand the node relating to your Portal EAR 

3. Expand the [WebLogic] node 

4. Right-click WebLogic J2EE Libraries and choose Add 

5. In the Add WebLogic J2EE Library reference window, click Browse 

6. In the Select WebLogic J2EE Library window, click Add 

7. In the Add WebLogic J2EE Library window, click Browse 

8. Look for alcs-uup-lib in the J2EE Library list. If you don't see it on the list add it as 
follows  

• Click the Add button 

• In the Add WebLogic J2EE Library window, click Browse 

• Browse to <BEA_HOME>/weblogic92/commerce/portal-plugins/uup 
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• Select alcs-uup-lib-5.1.ear and click Open. 

• Click the OK button. 

9. Select alcs-uup-lib from the list and click OK. 

10. Click OK in the remaining open windows. 

UUP in WebLogic Portal Administration Console 

Once you deploy your WebLogic Portal project, you should be able to access the AquaLogic 
Commerce Services Customer profile data from the WebLogic Portal Administration Console. 

1. Log in to the console. 

2. Select User Management from the Users, Groups, & Roles menu to display the user 
management page. 

3. From the list of users on the left, click on a user you created in Storefront. 

4. Click on the User Profile tab over on the right 

5. Ensure Profile Values for Property Set: is set to CommerceServices 

You should now be able to see the Customer Profile properties similar to the following: 

 

You can click on the Edit button to the right of any property to change the value of that property. 
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 A note about caching 

The UUP property values are cached, so a change made to a profile property 
in Storefront make take a few minutes to appear in the User Profile view in 
the administration console. However, changes you make to properties within 
the administration console should be visible immediately. 

Integrating with Back-End Systems 

AquaLogic Commerce Services includes support for integrating your AquaLogic Commerce 
Services store with external systems. 

AquaLogic Commerce Services Connect 

AquaLogic Commerce Services Connect integrates Apache Axis (an open source Web Services 
engine for Java) along with Dozer and XDoclet to expose services from the AquaLogic 
Commerce Services service layer as Web Services to external systems. 

For more information please read the AquaLogic Commerce Services Connect documentation in 
the AquaLogic Commerce Services Developer Guide. 

Integrating Business Process Management (BPM) 
Functionality 

AquaLogic Commerce Services can be used with AquaLogic Business Process Management 
(BPM). Using the AquaLogic BPM Suite you can easily register and consume Web services, such 
as the Web services provided by the AquaLogic Commerce Services Connect module. 

You can also integrate with AquaLogic Service Bus by configuring and registering AquaLogic 
Commerce Services web services with the service bus, configuring its related proxy services, and 
exposing them as Web services. AquaLogic Service Bus can help configuration and deployment, 
and it simplifies management of shared services across a SOA environment. 

For more information see the AquaLogic BPM documentation at 
http://edocs.bea.com/albsi/docs57/index.html, the AquaLogic Service Bus documentation at 
http://edocs.bea.com/alsb/docs26/index.html , and the AquaLogic Commerce Services Connect 
documentation. 

Hooking Into Your E-Mail Server 

AquaLogic Commerce Service's Storefront and Manager modules are capable of sending e-mail, 
for example when a new Customer registers on the store or requests their password to be reset. 
You can easily configure this functionality to use your mail server and details. 
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Configuration 

The e-mail configuration can be found in the file commerce-config.xml which is in the WEB-
INF folder of the Storefront and Manager modules. For example in the installed sample you 
would edit 
<BEA_HOME>/weblogic92/samples/commerce/commerceApp/commerceServices/WEB
-INF/commerce-config.xml and 
<BEA_HOME>/weblogic92/samples/commerce/commerceApp/commerceServicesMana
ger/WEB-INF/commerce-config.xml respectively. 

The configuration options in the <mail> section and are as follows 

Option Description 

mail.host The domain name or IP address of the SMTP server that will send e-mail 

mail.host.port The port of the SMTP server 

email.from The "From" e-mail address which e-mails appear to come from 

email.from.name The "From" personal name which e-mails appear to come from 

email.store.url The URL to use for images, etc in the e-mail from Commerce Storefront 

email.cm.url The URL to use for images, etc in the e-mail from Commerce Manager 

 

 

 

 

 




